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    Join us for Your

      27th Annual Military Retiree

                 Appreciation Day!

Saturday, 22 September 2001

Carlisle Barracks, Carlisle PA 17013

Retirement Services 717-245-4501/3894
ATZE-GC (600)


MEMORANDUM FOR MILITARY RETIREES, FAMILY MEMBERS, SURVIVORS AND 

                 PRE-RETIREE PERSONNEL

SUBJECT:  Carlisle Barracks Retiree Appreciation Day Invitation

1.  You are cordially invited to attend the 27th Annual Retiree Appreciation Day at Carlisle Barracks Root Hall on Saturday, 

22 September 2001.  The Keynote Speaker, Lieutenant Colonel Edward S. Gryczynski, United States Army Retired, Director, Personal Affairs, The Retired Officers Association, will update you on current retiree issues.  Five seminars will be offered on the following topics:  TRICARE(Under Age 65), TRICARE-For-Life(Over Age 65), Social Security, Veterans Affairs, and Legal Affairs.  The ID Card Section in Building 315 will be open from 0800 to 1330.  A “Mini-Health Fair” will be conducted from 0800 to 1000.  Several post activities and service organizations will be represented from 0800 to 1000.  The Commissary will be open until 1700.  The Post Exchange will sponsor special sales in your honor and the Root Hall Gift/Book Shop will be open from 0800 to 1330.  

2.  Please complete the pre-registration form in this bulletin and return it no later than 18 September 2001.  If you wish to attend the luncheon at the Letort View Community Center, you must pre-pay.  The cost is $12 and is non-refundable.  Make checks (NO CASH!) payable to:  Letort View Community Center or L.V.C.C., and mail to:  Retirement Services Office, MPD, Carlisle Barracks, 315 Lovell Avenue, Carlisle, PA  17013-5042.  Bus transportation will be available.  

3.  This Retiree Appreciation Day is a gesture of Carlisle Barracks appreciation for your service to our country.  Please set this day aside and take the opportunity to stay up to date on retiree issues.  If you have any questions, please feel free to call the Retirement Services Office at 717-245-4501/3894.

Enclosures




THOMAS T. SMITH








LTC, IN








Garrison Commander
RETIREE APPRECIATION DAY AGENDA
    PLACE:  Bliss and Root Halls, U.S. Army War College

    DATE AND TIME:  Saturday, 22 September 2001 0800-1500

    0800-0900  Registration  (Bliss Hall Foyer)

               Coffee & donuts available, Root Hall Gift/Book Store Open

    0900-0920  Presentation of Colors (Bliss Hall Auditorium)

               Pledge of Allegiance, Invocation, Welcoming Remarks

               Speaker Introductions

0900-1000 Keynote Speaker

1000-1015 Dunham Clinic Update

1015-1030 Break/Proceed to Seminar Session #1

1030-1125 Seminar Session #1
1125 Proceed to Letort View Community Center(LVCC)

1130-1300 Luncheon

1300-1350 Seminar Session #2
1350-1400 Proceed to Seminar Session #3

1400-1450 Seminar Session #3
1450-1500 Award of Door Prizes (Bliss Hall Auditorium)

HOT BUFFET LUNCHEON MENU
Tossed Salad, Baked Greek Chicken, Salisbury Steak,

Rice Pilaf, Mixed Garden Vegetables (Broccoli, Cauliflower & Carrots Mix), Fresh Baked Rolls & Butter, Assorted Desserts, Water/Coffee/Iced Tea/Tea

COST: $12  (this includes the 15% gratuity & the 5% service charge)

-------------------------------(CUT HERE)-------------------------------                                  

(DON’T WORRY, YOU WILL FIND THE WEB-SITES IN YOUR PRE-REGISTRATION PACKET! 

PLEASE MAIL to: Retirement Services Office PRIOR TO 18 September 2001
        CARLISLE BARRACKS RETIREE APPRECIATION DAY PRE-REGISTRATION FORM 

    YES, I plan to attend.  There will be ______ in my party.

                                         (Number)

    Please make ______ reservations for lunch at the LVCC--$_______.

               (Number)

    I have enclosed my check for $ _______, payable to:

                 Letort View Support Center or “LVCC”

The TRICARE (Under Age 65) seminar will be presented ONLY ONCE in Bliss Hall at 1030. The TRICARE-For-Life! (Over age 65) seminar will take place in Bliss Hall from 1300 – 1450!  SOCIAL SECURITY, LEGAL AFFAIRS & VA seminars will be presented during all three seminar sessions. Please check the seminars you wish to attend, being careful of the Bliss Hall Seminar times and how they affect your other choices. 

	BLISS HALL SEMINARS ONLY
	SEMINARS OFFERED DURING ALL SESSIONS

	TRICARE (under age 65)  ____ Sess #1(1030 hrs) in Bliss Hall Auditorium!  
	____ LEGAL      (Sess #1 or #2 or #3)

	TRICARE-For Life! (Over age 65!)    ____ Sess #2 & #3

(1300 hrs until 1450 hrs) in Bliss Hall Auditorium!  
	____ SOC SEC    (Sess #1 or #2or #3)                              

	THE TRICARE-FOR-LIFE SEMINAR CONTINUES IN BLISS HALL THROUGH SESSION #3!
	____ VA         (Sess #1 or #2 or #3)


    NAME __________________________________RANK_____SERVICE_________

    ADDRESS_________________________________________________________

           ____________________________________STATE____ZIP_________  

                         HANDY POST PHONE NUMBERS
                              717-24x-xxxx

      DUNHAM HEALTH CLINIC

Clinic Information




5-3915
Health Benefits Advisors



5-3918/53924  

      Immunizations





5-3308  

Medical Records




5-3915

Patient Appointments



5-3400/1-888-999-5195

Patient Appointment Cancellation Line

5-3325

Pharmacy





5-4509  

Pharmacy (Phone-in Refill)



1-800-248-6337  

      Space Available Appointments


5-3865


OTHER POST PHONE NUMBERS

Army Community Services



5-4357

Army Emergency Relief



5-4357

Art Studios 





5-3319

Automotive Center




5-3319

Barber Shop (PX)




249-4958

Barracks Crossing (Art, Frame, Auto)

5-3319

Beauty Shop (PX)




258-3202

Bowling Lanes





5-4109

Catering (Letort View Community Center)

5-3960

Class Six Store 




5-2275

Commissary 





5-3105

DEERS/ID Cards Section



5-3533

Education Center




5-3943

Financial Counsel




5-3209

Framing Studio & Custom



5-3319

Guest Housing Reservations



5-4245

Golf Course





243-3262

Grandstand Fitness Center



5-3228

ID Cards Section (DEERS)



5-3533

Invitation Ticketing & Registration Ofc

5-3309

Jim Thorpe Fitness Center



5-4375

Laundry & Dry Cleaning (PX)


258-1856

Legal Assistance/Appointments (JAG)

5-4940

Letort View Community Center


5-3991

Military History Institute



5-3972/53611

Optical Shop (PX)




249-5150

Outdoor Recreation Rentals 


5-4375

Passports/VISAs




5-3158

Post Exchange





243-2463

Retirement Services Office (Military)

5-4501/3894

Survivor Assistance Office (Military)

5-4501/3894

Theater (Post)




5-4108

Thrift Shop





243-1434

Veterinary Treatment Facility


5-4168

Weekly Bulletin




5-3520

HANDY TOLL-FREE NUMBERS

Armed Forces Vacation Club (Resort Condos)


1-800-724-9988

ARMY Reserve Retirement Benefits, St. Louis, MO

1-800-318-5298

Bureau of Veterans Affairs, Ft Indiantown Gap


1-800-547-2838 

DEERS Update/Information





1-800-538-9552

Social Security






1-800-772-1213 

MEDICARE







1-800-633-4227


Retirement Pay Center, Cleveland, OH



1-800-321-1080

Retirement Pay Center, Casualty Line, Cleveland, OH

1-800-269-5170

Survivor Benefits Annuity, Denver, CO



1-800-435-3396

TRICARE Claims Information (Under age 65)


1-800-578-1294

TRICARE Delta-Select Retiree Dental Program


1-888-838-8737

TRICARE For LIFE! (Over age 65)




1-888-363-5433

TRICARE General Information/Assistance



1-877-363-2273

TRICARE National Mail-Order Pharmacy Program


1-800-903-4680

TRICARE “PharmaCare” Info & Pharmacy Listing


1-888-999-5195 

TRICARE “PharmaCare” Problems for Pharmacists to Use 

1-800-777-1023

TRICARE Senior Pharmacy      (Over age 65)




1-877-363-6337

     
TRICARE Service Center





1-888-999-5195

VA Agent Orange Hotline





1-800-749-8387 

VA Insurance Information (NSLI)




1-800-669-8477

VA Insurance Information (VGLI)




1-800-419-1473

VA GI Bill Information





1-888-442-4551

VA Gulf War Vets






1-800-749-8387

VA Regional Office (General Questions)



1-800-827-1000

VA TDD (Telecomm. Device for Deaf)



1-800-829-4833

ID Card Sections in Pennsylvania - PLEASE CALL FIRST!


  TOWN
     

SERVICE



   PHONE


Allentown

National Guard Armory


610-821-6155 


Allentown

US Navy Reserve Center 


610-264-8823


Annville

Army National Guard 


717-861-8693 


Avoca


US Navy Reserve Center


717-457-8430


Carlisle

Carlisle Barracks-US Army


717-245-3533



Connellsville

US Marine Corps Reserve Center

412-628-9181


Coraopolis

Air National Guard 



412-474-7485

 
Ebensburg

US Navy Reserve Center


814-472-5083


Erie


US Navy Reserve Center


814-866-3073


Mechanicsburg

US Navy




717-605-2726/3778 


Middletown

Air National Guard



717-948-2248 


Norristown

US Army Reserve Center


610-239-1803


Oakdale

US Army




724-693-2475/6


Pittsburgh (IAP)
US Air Force Reserve 


412-474-8526


Pittsburgh 

US Navy Reserve



412-673-0809


Reading 

US Navy Reserve



610-378-0164


Tobyhanna

US Army




570-895-7494

Williamsport 
US Navy Reserve




717-323-7991

Willow Grove 
US Navy





215-443-6863

MILITARY RETIREE WEB SITES!

1. Air Force Retiree News www.afpc.randolph.af.mil/afretire
2. Arlington National Cemetery www.arlingtoncemetery.org
3. Armed Forces Recreation Centers http://trol.redstone.army.mil/mwr/afrcs/index.html
4. Armed Forces Recreation Centers in Europe http://www.afrceurope.com/home.html
5. Armed Forces Vacation Club www.afvclub.com/search.asp
6.  Army Morale Welfare and Recreation http://trol.redstone.army.mil/mwr/index.html
7.  Army Outdoor Recreation www.pathsacrossamerica.com
8. Army Retiree News www.odcsper.army.mil/retire
9. Carlisle Barracks Web Site http://carlisle-www.army.mil
10. DeltaSelect Tricare Retiree Dental Program  www.ddpdelta.org
11. Federal Web Locator www.infoctr.edu/fwl
12. Medicare  www.medicare.gov
13.  National Archives and Records Administration http://www.nara.gov/nara/
14.  National Mail Order Pharmacy Program Formulary www.pec.osd.mil/nmop/nmophome.htm
15.  National Mail Order Pharmacy Program (Merck-Medco) www.merckmedco.com
16. National Personnel Records Center www.nara.gov/regional/mpr.html
17. Navy Lodges www.navy-nex.com
18. PA Dept of Mil & Veterans Affairs www.sites.pa.us/PA_Exec/Military_Affairs/va.index.htm
19. Reserve and National Guard Retirement Infowww.2xcitizen.usar.mil/soldierservices/retirement
20.  Retired and Annuity Pay www.dfas.mil/emss
21. Sierra Military Health Services, Inc. http://www.sierramilitary.com
22.  Sierra Military Health Services Provider Search www.sierramilitary.com/provsearch
23.  Social Security www.ssa.gov
24.  Space A Travel Information http://public.scott.af.mil/hqamc
25.  Tricare Management Activity www.tricare.osd.mil
26.  Tricare for Life www.tricare.osd.mil
27.  Tricare Senior Pharmacy Program www.tricare.osd.mil/pharmacy/newsenior.htm
28.  Veterans Administration Information http://www.va.gov
29.  Veterans Administration National Cemetery http://www.cem.va.gov
Updated 14 July 2001

“TRICARE for LIFE” & the TRICARE Senior Pharmacy Program (TSRx) for Medicare-eligible Military Retirees, Spouses, & Surviving Spouses


 There are new health benefits for MEDICARE-eligible military retirees (including Reserves & National Guard), spouses and their surviving spouses. 

    TRICARE Senior Pharmacy Program (TSRx) began on 1 April 2001. For more info on the TSRx, call 1-877-363-6337. There are two programs available for you to get prescriptions filled!  

    1.  The National Mail-Order Pharmacy Program costs for your long-term maintenance prescriptions is $3 co-pay for Generics or $9 co-pay for Brand Name prescriptions. A 90-day supply of non-narcotic medications and up to 30-day supply of narcotic medications may be filled. For more information on the Mail-Order Pharmacy Program call 1-800-903-4680 or check www.pec.ha.osd.mil/nmop/nmophome.htm. 


  2. “PharmaCare”, a Local Network Retail Pharmacy Plan, for short-term prescriptions.  You pay the same $3 co-pay for Generics or $9 co-pay for Brand name prescriptions for up to a 30-day supply.  For more information and the list of your local participating pharmacies call 1-888-999-5195 press 3 or check www.sierramilitary.com/provsearch/pdmain.asp.  
“TRICARE For LIFE” started 1 October 2001!  It is a FREE Supplement to MEDICARE. TRICARE will pay all co-payments and deductibles.  You must be enrolled and paying for Part B of Medicare. You can go to any doctor so long as the doctor accepts Medicare patients.  The doctor will bill Medicare & Medicare will bill TRICARE for any unpaid portions.  For most current information on “TRICARE for LIFE”, check out www.tricare.osd.mil or call 1-888-999-5195.

If you are a spouse or a surviving spouse of a military retiree and your military ID Card is expired or you do not have one, you must get an ID Card!  Please call the Carlisle Barracks ID Card Section at 717-245-3533. If you have an ID card but have not heard about these benefits, please call 1-800-538-9552.  Call your Retirement Services at 717-245-4501 if you have questions.  Carlisle Barracks Retirement Services Office, updated 25 October 2001   

Around the Barracks


Information, Ticketing & Registration (ITR) Office


The ITR Office offers a variety of discount prices on Day/Special Events, Disney, tickets to local and national attractions, hotel accommodations and much more!  One example is Hershey Park Tickets for Adults (9-54) $26.50 instead of $33.95, Child (3-8)-$18.50 instead of $18.95.  Daytrips offered are to Washington DC National Zoo & Sightseeing for only $25 per person on Sat, 1 Sep 01; Football Game in Baltimore on Sun, 28 Oct 01 Ravens vs. Jaguars $45 & the Army-Navy Game on 1 Dec 01 in Phila $67.  Contact the ITR office Mon – Fri, 8:30 a.m. – 5:00 p.m.  The phone number is 717-245-3309/4048, by email � HYPERLINK "mailto:itrofc@carlisle.army.mil" ��itrofc@carlisle.army.mil�, or visit the website at � HYPERLINK "http://www.carlislemwr.com" ��www.carlislemwr.com�. 


�


�


Vehicle Registration Highly Encouraged! Due to heightened security restraints on military facilities, it is recommended that all military retirees and family members, to include surviving spouses, get their vehicles registered through the Military Police station.    If you wish to get your vehicles registered at Carlisle Barracks, you’ll need to go to Bldg 400, the MP Station is under the Fire Station.   You must have your valid military ID card, state driver’s license, state vehicle registration, & proof of insurance.  For more information, please call the MP station 717-245-4406. 




















�








U.S. Army


The Retirement Services Office in conjunction with the Carlisle Barracks Retiree Council publishes the Carlisle Barracks Retiree Bulletin. 


 Comments should be mailed to Theresa A. Derr, RSO                     MPD, Carlisle Barracks                     315 Lovell Avenue                      Carlisle, PA  17013-5042 or               call (717) 245-4501 or                       email at � HYPERLINK "mailto:Theresa.derr@carlisle.army.mil" ��Theresa.derr@carlisle.army.mil�





Request U.S. Navy, U.S. Air Force, U.S. Marine Corps, U.S. Coast Guard, Retired & their Annuitants & those who specially requested the Bulletin, write in with any address changes.


U.S. Army Retired & Army Annuitants do not have to mail us your address changes! Your address changes come from DFAS-CL & DFAS-DE!


�


Carlisle Barracks Retiree Bulletin


         





FYI from Your RSO


The Retiree Appreciation Day at Carlisle Barracks is scheduled for 22 September 2001!  Call the ITR Office at 717-245-3309 to make hotel reservations!


 Welcome!  The greatest changes are the TRICARE Senior Pharmacy Program (TSRx) and the TRICARE-for-Life (TFL)!!  The phone calls and walk-in visits have been numerous and the April 1st start date of the TSRx, was a great success!  Join us for the special TFL Seminar set for your Appreciation Day!  I have added an “Info Sheet” to be used in spreading the word about these new benefits.  Make copies to drop off at your pharmacy, doc’s office, community center, and churches in case there is someone out there eligible for these benefits but are not aware of them.  Word-of-mouth is a strong means of getting the information out!  There are many spouses & surviving spouses who never renewed or ever had a Military ID Card!  They thought they didn’t need one because it was only good for shopping on post & it was too far to travel.  They are totally unaware of their new benefits!  I’ve  also expanded the Handy Phone list & the Web-site list! Enjoy!  Hope to see you on Saturday, 22 September 2001 for your Retiree Appreciation Day! 


Finance Update


Retirees:  DFAS-CL, P.O. Box 99191, Cleveland, OH 44199-1126. 					    TF# 1-800-321-1080 & 1-800-269-5170.                    TF FAX# 1-800-469-6559.


Annuitants:  DFAS-DE, ATTN: DFAS-DE/FRB, 760 E. Irvington Place, Denver, CO 80279-6000.                TF# 1-800-435-3396. TF FAX#1-800-982-8459.





DFAS-Cleveland & DFAS-Denver Contracted Out!


 Your Retired pay from DFAS-Cleveland, OH & your Annuity Pay from DFAS-Denver, CO are being contracted out to a civilian firm called “ACS Government Services.”  The award must now go through a public review and an appeals process.                       If the contract award is finalized, ACS should take over later this year.  


   The plan is for the Retirement Pay Center in Cleveland, OH and the Annuity Pay Center in Denver, CO to continue as such for the first year.  However, during the second year, the Annuity Pay Center from Denver, CO will be relocated and consolidated to the Retirement Pay Center in Cleveland, OH.  We are all hoping that the only difference in service will be that instead of hearing “DFAS-Cleveland” or “DFAS-Denver,” you’ll hear “ACS Government Services”.


…I don’t have to complete that little form I got from DFAS-Cleveland since my Will says what I want done with my final pay…Right!?


WRONG!  DFAS-CL does NOT pay your final month’s Retirement pay, also called the Arrears of Pay (AOP), in accordance to your Will.  If you do not specifically complete that form with the names(s) of your loved one(s) whom you really want as your beneficiaries, your money may be given to family members you do not really want to see get the money.  It’s very hard on families with no surviving spouse, but with many children.  Each child has to complete a claim form, in order to get an equal payment of what you would have gotten from the first of that month until the day of your death. 


VA NEWS


Questions concerning articles in this section may be referred to your County Veterans Director (in the blue pages under Government Office – County) or your VA Regional Office   1-800-827-1000.


Registry Exams for Vets Possibly Exposed to Agent Orange in Korea


The DoD recently released information that Agent Orange was used in Korea from 1968 to 1969.  21,000 gallons of Agent Orange was sprayed from the Civilian Control Line to the southern boundary of the DMZ.  Korean troops did the actual spraying.  However, it is possible that the approx.  80,000 U.S. service members may have been exposed during this period.   If requested, the VA will provide veterans with an Agent Orange Registry (AOR) exam, consultation, and counseling. Participating vets will automatically be added to the mailing list for VA’s Agent Orange Review.  However, these vets are not entitled to compensation or to priority health care based upon the possible exposure of Agent Orange.  You may ask, “Why Should I request an exam?”  Who would have thought Type II Diabetes would be presumed disease process to Agent Orange?!  Maybe in several years, if enough vets get the exams and a large enough percentage have the same presumptive diseases as the Vietnam vets, the VA may change the rules and you WILL be eligible for compensation and priority health care! (VHA Directive 200-027 5 Sep 2000) 


AGENT ORANGE & CHILDHOOD LEUKEMIA


On 19 Apr 2001, VA Secretary Anthony Principi, announced that he will seek Congressional authority to provide benefits for the children of Vietnam vets who contracted a rare, deadly form of leukemia known as Acute myelogenous leukemia (AML).  It is one of the most difficult leukemias to treat & is almost always fatal.  A report by the Institute of Medicine  (IOM) found “limited or suggestive” medical evidence of a link between AML and a parent’s service in Vietnam.  There were 3 studies – 1-involving vets who served in Vietnam or Cambodia; children of Australia’s Vietnam vets, who had a 4-fold greater incidence of the disease; & children of fathers exposed to pesticides & weed-killers like Agent Orange, who had a nearly 3-fold greater incidence.   (VA-OPA/Media Relations)


Pane m eThere ontmedIn response, the White House approved to  to therP  iSrthe MtiosFreYou can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.(























TRICARE INFO


�


Special Note to All!  With the new TRICARE benefits that include the over age 65, Medicare-Eligible Military Retirees, Spouses & Surviving Spouses, I decided to limit this column to informational phone numbers & addresses.  See my “TRICARE for Life” & TRICARE Senior Pharmacy Program (TSRx)  Information Paper & Handy Phone Listings!  Please spread the word!    	�


ARMY ECHOES CORRECTION!  The Army Echoes erroneously indicated on page 11 that the National Mail Order Pharmacy Program is for a 30 day-supply only.  If the prescription is non-narcotic in nature – you can get a 90-day supply!


�


Your Local Health Benefits Advisors


Dunham Clinic, Carlisle Barracks	     717-245-3924     Naval Br Clinic, Mechanicsburg	     717-605-6137     Army Health Clinic, New Cumberland   717-770-4941 Tobyhanna Army Depot, Tobyhanna     570-895-7225    Naval Air Sta, Willow Grove	     215-443-6357       C.E. Kelly Suppt Ctr, Oakdale	     724-693-2475


�


Pennsylvania’s Listing of Sierra Military Health Svcs. Inc., TRICARE Services Centers for Walk-in Assistance!


SMHS, Inc., Carlisle Barracks, RT 11 (Turn Right out the Front Gate), Carlisle, PA  17013


SMHS, Inc., 34 W. Main St., Suite 4, Palmyra, PA  17078


SMHS, Inc., 11 Parkway Center, Suite 225, 875 Greentree Rd., Pittsburgh, PA 15220


SMHS, Inc., 2 International Plaza, Scott Office Building 635 (6th floor), Essington, PA 19013   


�




















Calendar of Events


Special Event


Place


Time


Type a description of your event here.


Special Event


Place


Time


Type a description of your event here. 


Special Event


Place


Time


Type a description of your event here. 


Special Event


Place


Time


Type a description of your event here.
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